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Where to Find the Latest Information

Agilent will periodically update product documentation. For the latest information about this wireless test
set, including software upgrades, operating and application information, and product and accessory
information, see the following URL: http://www.agilent.com/find/pxt

Is your product software up-to-date?

Agilent will periodically release software updates to fix known defects and incorporate product
enhancements. To search for software updates for your product, go to the Agilent Technical Support
website at

http://www.agilent.com/find/softwaremanager

An active N6050AS software and technical support contract (STSC) is required to access the
software manager website (displayed above), together with the login credentials registered
by you or your company for activation. See the section on licensing in the Agilent PXT
Wireless Communications Test Set Getting Started Guide for instructions to activate your
STSC.
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Introduction

Welcome to the N6062A LTE Message Editor User’s Guide for the Agilent E6621A PXT Wireless
Communications Test Set (PXT). The purpose of this guide is to provide you with installation instructions and
user information for the Agilent N6062A LTE Message Editor (N6062A) software application. For more
information about the PXT and other PXT software products, refer to the Agilent PXT Wireless

Communications Test Set Getting Started Guide and the Agilent PXT Wireless Communications Test Set
User's Guide.

Latest Documentation

For the latest version of all documentation, please go to www.agilent.com/find/pxt.

Latest Software Application Releases

For the latest release of all PXT related software, please go to
http://www.agilent.com/find/softwaremanager.

An active N6050AS Software and Technical Support Contract (STSC) is required to access
the software manager website (displayed above), together with the login credentials
registered by you or your company for activation. See the section on licensing in the Agilent

PXT Wireless Communications Test Set Getting Started Guide for instructions to activate
your STSC.



file:///C:/Documents%20and%20Settings/mancinel/My%20Documents/MBO/PXT/Final_Manuals/GetStrt/First_Review/www.agilent.com/find/pxt
http://www.agilent.com/find/softwaremanager
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2 System Architecture

The N6062A LTE Message Editor software application runs on PCs using the Microsoft (MS) Windows XP/
Windows 7 operating systems. The N6062A is connected to the PXT via a private Ethernet interface to enable

you to create and modify scenario files for download into the PXT. An example N6062A user interface is
shown below.

# N6062A Protocol Message Editor - [Band7_10MHz_UM_TM3_LSTI_IntegrityDisabled_v1.0.LBMF (2009-... [:]

™ FEile Edit Encode View Window Help -8 x
EIENEIN=REYEY
Band7_10MHz_UM_TM3_LSTI_IntegrityDisabled_v1.0.LBMF (2009-03)
o Ele @Y ESe
= RRC Message List = &’ Message Name : RRCConnectionSetup 2
SBL - = Fa DL-CCCHMessage
_nnnectn:u-r;:etup oy ;:_f ssage
MIB et F
DLInformation_Auth = g rreConnectionSetup )
DLInformation_SecCommand §? me-Transactionldentifier : 0
Secuntymodgc_gmmand = By criticalExtensions
UEcapEnquiry 3oy ¢t
RRCRecaonfiguration =] h rreConnectionSetup-r8 =
RRCConnectionRelease = Ta radioResourceConfigDedicated
T stb-ToAddModList
- Fa SEQ1
P stb-ldentity : 1
= B9y rle-Config
4 defaultvalue
= By logicalChannelConfig
£ defaultvalue
4 drb-ToAddModList
% drb-ToReleaseList
= 2oy mac-MainConfig
= Ta explicitvalue
= T8 ul-SCH-Config
@ maxHARQ-TX : n§
@ periodicBSR-Timer : 5110
ER rotBSR-Timer - 4220 he
Detail Information 1oumur ]Hex Wiewer
MName Value
Message Name RRCConnectionSetup
Message Type DL-CCCH-Message
Encoded Data Ox60129B3E820F635EF259B0C190281C120. .
Encoded Length D... 18
Decoded Data equal
Eorre | Eonas | B0 | RS

Figure 2-1: N6062A Message Editor
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3 N6062A Software Installation

Installation Computer Minimum Requirements

For successful operation, the installation computer for the N6062A LTE Message Editor must meet or exceed
the following specifications:

Minimum System Requirements

Operating System

Computer running Windows XP or Windows 7

Communication
with Test Set(s)

Ethernet

RAM (Memory)

4 GB RAM (Minimum)

Processor

>2.5 GHz Intel Pentium® Quad core or equivalent

.NET Framework

Version 2.0 or later

NOTES:

1. Consideration for storage space should be given for storing scenario files and supporting

documentation.

2. A clean installation of the Operating System is required to ensure freedom from Ad-ware, Spy-ware,

updaters and other processor resource consuming applications. For expected performance, Antivirus
software should not be running.

3. Connecting the PXT and the message editor PC to a network is not recommended.

Downloading the Latest Version of N6062A Message Editor Software

To ensure you have the latest version, download the N6062A software from the Agilent software manager

web site. To access this site, you must first register and activate your N6050AS Software and Technical
Support Contract (STSC) for the E6621A PXT.

If you have not already done so, follow the instructions on your N6050AS Entitlement Certificate to activate
your Contract. For more information on activating licenses, see the section on licensing in the Agilent PXT
Wireless Communications Test Set Getting Started Guide for instructions to activate your STSC.

On the www.agilent.com/find/softwaremanager download site, locate the N6062A Message Editor Software,
and save it to a location on your PC.

Locate the file on your PC and double-click the setup file to install the software. Follow the on-screen
instructions to complete the installation.

Before running the software, plug your N6062A USB license key into your PC.

Always check the release notes for the latest information about any known
issues and other important information about your product. Release notes are
available for download from www.agilent.com/find/softwaremanager.
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Connecting the Computer and Test Set
Connect the N6062A LTE Message Editor installation computer to the LAN port on the E6621A PXT rear

panel.
NB062A Message Editor Software
License Key
[ & =3
‘. Wired LAN connection
] —
EB621A PXT Optional UE client PC

USB connectionto client PC

Optional second
CONNECION fOr  |—
MIMO test /

UE under test

Figure 3-1: System Configuration

Launch the N6062A Message Editor Software

Start the N6062A LTE Message Editor application from the Windows Start menu by selecting Start,
All Programs, Agilent PXT, N6062A Message Editor, N6062A, or by double-clicking on the

3

desktop icon.  Me0&2A
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4 Menus for N6062A LTE Message Editor

The N6062A Message Editor is presented in a single window. Some functions are available from the menu bar.
Frequently used functions are duplicated in the tool bar.

The Menu Bar
File Edit Encode View Help

There are five drop-down menus: File, Edit, Encode, View, and Help. Before any files have been opened, only
two menus are displayed: File and Help.

Using your mouse to select the following menu options performs the described task:

The File Menu

The N6062A Message Editor works with a file type known as a scenario file which contains message
definitions and defines the desired sequence of messages exchanged between the PXT and a UE. These file
types have an .LBMF file extension.

Mew_. Ctrl+M
| & Open._. Ctrl+0
| Close
= Cirl+s
| Save All  Ctrl=Shift+5
Save As._.
9  File Transfer...
== Print k
Exit
Top Level Drop-Down Menu Task Performed
Menu Option Options
File Opens the Drop-Down Menu
New... Creates a new scenario file.
Open... Opens an existing scenario file.
Close Closes the active scenario file.
Save Saves the active scenario file.
Save All Saves all open scenario files.
Save As Save a scenario file with a different name or
location.
File Transfer... e Downloads a scenario file to the PXT.
e Uploads a scenario file from the PXT.
Print Selects the file for printing.
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Top Level Drop-Down Menu Task Performed
Menu Option Options
File (Continued) | File, Print Prints selected scenario file.
Tree Print Print an individual message.
File Preview Provides a preview of the selected scenario file.
Tree Preview Prints a preview of the individual message.
Exit Closes the application.

The Edit Menu

& Insert Message...

@ Delete All
@ Delete Selected Message

Top Level Drop-Down Menu Command Task Performed

Menu Option

Edit

Insert Message Inserts a new RRC or NAS Message into
the scenario file.

Delete All Deletes All RRC or NAS Messages from
a scenario file.

Delete Selected Message Deletes a selected RRC or NAS
Message from a scenario file.

The Encode Menu
Encode

@ Encode All
w#  Encode Selected Message

Top Level Drop-Down Menu Command Task Performed

Menu Option

Encode
Encode All Encodes all RRC or NAS Messages in a
scenario file.
Encode Selected Message Encodes a selected RRC or NAS
Message.




The View Menu

RRC Editor

NAS Editor
Scenario Editor
Extended Editor

4] El(l[‘lﬂg

Properties...

Top Level Drop-Down Menu Command
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Task Performed

Menu Option

View

RRC Editor

Displays the RRC Editor window.

NAS Editor

Displays the NAS Editor window.

Scenario Editor

Displays the Scenario Editor window.

Extended Editor

Displays the Extended Editor window.

Properties

Displays the properties of the .LBMF file.
e File Name
e File Path
e Spec Version
e RRC Version
e NAS Version

e Description

The Help Menu

Help
About...

o Click About... to display the About (Version Information) Window.

The Tool Bar

The Tool bar provides quick access to frequently used functions.

Bl w8 1_“_31,’.@' Q| %

VIR IREEEEY IR i g S g Ty

o The - icon duplicates the function of File, New (Ctrl+N)

e The ™ icon duplicates the function of File, Open (Ctrl+0)
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The &
The +
The &

The

The

icon duplicates the function of File, Save (Ctrl+S)
icon duplicates the function of File, File Transfer (Ctrl+S)

icon duplicates the function of View, LTE BSE ME, NAS Editor, Scenario Editor,

Extended Editor

Y
Q

icon enables the function of Search.

icon duplicates the function of View, Properties

The Tool bar provides quick access to frequently used functions.

e

The

o=
H=
b=

The E=

The
The
The

The

The
The

The

- E®e| 7

icon duplicates the function of File, New (Ctrl+N)

icon displays the Hex viewer window

icon changes Sorting Type

icon expands All Message List

icon duplicates the function of Encode, Encode Selected Message

icon expands All Message List in RRC Message window

icon duplicates the function of File, Print
icon duplicates the function of Encode, Encode Selected Message

icon edits Value in RRC Message window
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b Scenario File Overview

The N6062A LTE Message Editor provides the ability to create and modify a type of file known as a scenario
file. Scenario files contain message definitions and a desired sequence of message exchanges at the RRC
level between the PXT and a UE. Since many RRC messages also contain NAS messages, the N6062A also
enables the creation of NAS messages. These can be included as payload in the generated RRC messages.

The content of the RRC messages also determines lower layer behavior. For example, the Bandwidth of the
cell is defined using the dI-Bandwidth parameter in the Master Information Block.

Scenario files are downloaded to the PXT via the N6062A LTE Message Editor, where they are then selected
to run from a menu on the PXT.

Message Editor Fields that can be Over-written by PXT Front-panel Menu Keys

When a scenario file is loaded on the PXT, the parameters from the scenario file that have PXT menu keys
associated with them are updated on the PXT to reflect the values from the scenario file. The table below
shows those values from the scenario file that can be changed using the PXT front-panel menu keys without
requiring modification of the scenario file using the N6062A LTE Message Editor.

Message Editor Field PXT Menu Key Key Path

freqBandindicator controls which Band Freq
frequency band is transmitted in System
Information Block 1(SIB1).

dl-bandwidth determines the channel CH Bandwidth Mode > BSE > Mode Setup
bandwidth defined in the Master
Information Block (MIB) message.

transmissionMode controls the Transmission Mode | BSE > Mode Setup> More > RRC
transmission mode assigned in the RRC Settings

Connection Setup message. If this value is
set to TM3 or TM4, the codebook subset
restriction field is also enabled.

p-Max is carried in SIB1 and provides a p-Max BSE_> Mode Setup> More > RRC
value for the maximum power the UE is Settings

allowed to transmit. If this value is not

present in the scenario file, the p-Max

On/Off setting is overwritten, but this

setting is not.

p-Max On/Off determines whether the p- p-Max On/Off BSE > Mode Setup> More > RRC
Max value is present in the scenario file by Settings

controlling whether the Information
Element (IE) is present or not.

p0-NominalPUSCH contributes towards the | p0-NominalPUSCH | BSE > Mode Setup> More > RRC
power of the PUSCH and is carried in SIB2. Settings
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Message Editor Field

p0-UE-PUSCH contributes towards PUSCH

power and is carried in the (RRC
Connection) Setup message.

PXT Menu Key
p0-UE-PUSCH

Key Path

BSE > Mode Setup> More > RRC
Settings

defaultPagingCycle controls how
frequently the UE can be paged and is
contained in SIB2.

Default Paging
Cycle

BSE > Mode Setup> More > RRC
Settings

nB controls how frequently the UE can be NB BSE > Mode Setup> More > RRC
paged and is contained in SIB2. Settings
additionalSpectrumEmission controls how | Additional BSE > Mode Setup> More > RRC

much leakage the UE is allowed into
adjacent frequencies and is contained in
SIB2.

Spectrum Emission

Settings

PDNAddressInformation is the IP Address
assigned to the UE in the Activate Default
EPS Bearer Context Request message.
Since this is #1, it is the IP address that is
contained inside the (Non-Access Stratum)
NAS Attach Accept message.

DUT IP Address #1

BSE > Mode Setup> More > RRC
Settings

MCC is carried in SIB1 and also exists in MCC BSE > Mode Setup> More > RRC
the NAS Attach Accept message, if Globally Settings

Unique Temporary ldentity (GUTI) is

present. This setting overwrites both of

these values.

MNC is carried in SIB1and also exists in MNC BSE > Mode Setup> More > RRC

the NAS Attach Accept message, if Globally
Unique Temporary Identity (GUTI) is
present. This setting overwrites both of
these values.

Settings

This setting controls the number of digits of
MNC. It is carried in SIB1and also exists in
the NAS Attach Accept message, if Globally
Unique Temporary Identity (GUTI) is
present. This setting overwrites both of
these values.

2 or 3 Digit MNC

BSE > Mode Setup> More > RRC
Settings

drx-Config determines if the DRX Config IE
in the RRC Connection Reconfiguration
message is set to setup or release.

Connected DRX
On/Off

BSE > Mode Setup> More > RRC
Settings > More

longDRX-Cycle is related to Connected
Mode DRX and is present in the RRC
Connection Reconfiguration message.

longDRX-Cycle

BSE > Mode Setup> More > RRC
Settings > More

10




Message Editor Field

longDRX-CycleStartOffset is related to
Connected Mode DRX and is present in the
RRC Connection Reconfiguration message.

PXT Menu Key

longDRX-
CycleStartOffset
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Key Path

BSE > Mode Setup> More > RRC
Settings > More

onDurationTimer is related to Connected
Mode DRX and is present in the RRC
Connection Reconfiguration message.

onDurationTimer

BSE > Mode Setup> More > RRC
Settings > More

drx-InactivityTimer is related to Connected
Mode DRX and is present in the RRC
Connection Reconfiguration message.

drx-InactivityTimer

BSE > Mode Setup> More > RRC
Settings > More

shortDRX is related to Connected Mode
DRX and is present in the RRC Connection
Reconfiguration message. This field
controls whether shortDRX IE is present or
not.

Short DRX Cycle
On/0ff

BSE > Mode Setup> More > RRC
Settings > More

shortDRX-Cycle is related to Connected
Mode DRX and is present in the RRC
Connection Reconfiguration message.

shortDRX-Cycle

BSE > Mode Setup> More > RRC
Settings > More

shortDRX-CycleTimer is related to
Connected Mode DRX and is present in the
RRC Connection Reconfiguration message.

drxShortCycleTimer

BSE > Mode Setup> More > RRC
Settings > More

11
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6 Creating a New Scenario File

It is often easiest to start with an existing scenario file as a template and make modifications from that.
However, you may want to create a new scenario file to use as a completely blank canvas.

a

1. Click New Insert Icon

or Click File, New

LTE Spec Yersion | 2003-06

RRC Messages | NAS Messages

“Wersion 86,0

POU Type Insert Message

Type Type
BCCH-BCH-Message
BCCH-DL-5CH-Message
PCCH-Message
DL-CCCH-Message
DL-DCCH-Message
UL-CCCH-Message
UL-DCCH-Message
UECapabilitylnformation
UE-EUTRA-Capabilty
VarMeasConfia

VarMeasReportList
YarShorMAC-nput
HandoverCommand
HandoverPreparationinformation
UERadiosceeseCapabiliyinformatien

Figure 6-1: Creating New Scenario File

2. Click the OK button, This creates a new, blank, scenario file.

3. Save this under an appropriate name before making further edits to it.

12
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71 Creating and Changing a Scenario File

After you save a new scenario file or open an existing one, you see four tabs at the bottom left of the
scenario file window, which enables you to access the various functions of the N6062A Message Editor. They
are described in each of the sections below:

The RRC Window

NAS Window
Scenario Window

Extended Window

The RRC Window

1.
2.
3.

The N6062A LTE Message Editor provides a comprehensive tool for generating and manipulating RRC
messages.

The RRC Message List box displays all the user defined RRC messages. By clicking on the Insert Message
button, you can easily insert, delete, and edit RRC messages. You can select an individual message on the
list to view its structure and parameters on the Message Structure box to the right of the RRC Message List.

# N6062A Protocol Message Editor - [Band7_10MHz_UM_TM3_LSTI_IntegrityDisabled_v1.0.LBMF (2009-... @@@

™ FEile Edit Encode View Window Help o el £2
BT
Band7_10MHz_UM_TM3_LSTI_IntegrityDisabled_v1.0.LBMF (2009-03)
-
| |
= F&' Message Name : RRCConnectionSetup A~
= Ta DL-CCCHMessage
= 80 message
=g ot
Dlinformation_Auth = Fa rreConnectionSetup
DLInformation_SecCornmand 1§ me-Transactionldentifier : 0
SecuritymodeCommand = g criticalExtensions
UEcapEnquiry Rey o1
RRCReconfiguration = Fa mcConnectionSetup-r8
RRCConnectionRelease = Tg radioResourceConfigDedicated
= TR stb-ToAddModList
= Tg sEQ1

P srb-Identity : 1

alChannelConfig
£ defaultvalue
4 drb-ToAddModList
%k drb-ToReleaseList
(= 3oy, mac-MainConfig
= Ta explicitvalue
= T8 ul-SCH-Config
@ maxHARQ-Tx : n§
@ periodicBSR-Timer : s110

£ rotRER Timer - ¢f220 he
Detail Information | Output | Hex Viewer
Name Value
Message Name RRCConnectionSetup
Message Type DL-CCCH-Message
Encoded Data Ox60129B3E820F635EF259B0C190281C120...
Encoded Length D... 18
Decoded Data equal

ERrC | EEINAs

Figure 7-1: RRC Message Structure
Click on the Insert Message icon. The window below is displayed.

Select PDU Type.

Double-click or drag and drop to insert a new message.

13
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4. Name the message by double-clicking in the Name column and typing the desired name. (For example:
“Master Information Block”)
| New Messages ﬂ
LTE Spec Yersion : [ZDDS—DE -I
FRC Messages | NAS Messages
Version i G610
PDU Type Insert Message
Type Type Mame Yalue
BCCH-BCH-Message BCCH-BCH-Message Master Information Block
BCCH-DL-SCH-Message
PCCH-Message
Figure 7-2: Insert a New Message Type
5.

A message can be created directly by inserting a hex value into the Value column or this can be left blank.
6. Click the OK button.

A new message now appears in the RRC Message List. The message name appears in red, indicating that it
still needs to be encoded.

If a hex value has been specified for the message, a decoded RRC message corresponding to that hex value
appears on the right-hand side, when the message name is highlighted.

If the hex value has not been specified, a blank message corresponding to the selected PDU type appears in
the right-hand side.

@ LTE Message Editor - [newl (2009-06)¢]

[ Fle Edit Encode View Help

B mE T O %

newl (2009-06)+

|
==
£ £ Message Name : MasterlnformationBlock
=-Pg BCCH-BCH-Message
£ 2g message
@ di-Bandwidih : 6
=-Fg phich-Config
@ phich-Duration : normal
@ phich-Resource : oneSisth
s syetemFrameNlumber 0000000 lengih &
s spare + ‘0000000000 length 10

Detail Information | Output | Hex iswsr
e Meszage [

jold Encode Value : O

new Encode Value : 0x000000

TEncode Success

ESFRC [ENAS | E2Scenario | ESExtended

Figure 7-3: New RRC Message

The fields of the message can be manipulated by selecting a modifiable parameter on the right-hand side,

right-clicking and selecting Value Changed. Depending on the field type, a value can either be entered
directly, or chosen from an enumerated list.

Any applied changes to an RRC message on the list are not finalized unless
the message is encoded again.
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Detail Information

Output

Hes Wiewer

Message Tupe
Encoded Data
Encoded Length Data
Decoded Data

Agilent LTE N6062A Message Editor
User’s Guide

BCCH-BCH-Maessage
0x690C43

3

equal

Detail Information | Output | Hewx Wiewer Detall Information | Output | Hex Viewer
Mame Walue This Message [MasterlnformationElock] Encode Success Mame Type Value
M . old Encode Value @ 0xB90C43 "
essage Mame MasterinfarmationBlock |y Encade value © (wB90C43 MasterinformationBlock  BCCH-BCH-Message  0<E90C43

Figure 7-4: Detail Information - Output - Hex Viewer

The Input box (the top-right-side window, where you can change values) shows a brief summary of a
selected item. Once you encode an item, the result will be shown in the Qutput box.

NAS Window

Non-Access Stratum (NAS) Editor enables you to easily generate and decode encoded HEX NAS data. These
are very important features to create a wide range of PXT scenario files. Generated, encoded HEX NAS data

can be used in the N6062A to generate RRC messages containing NAS data; any received NAS messages on
the eNodeB emulator side can be decoded for debugging.

It is not sufficient to construct an NAS message for it to be included in a
scenario file — the hex content associated with the NAS message must
appear inside an RRC message for it to be sent to the UE during a message

exchange.

.. NAS Message Insert

version :  |B.1.0

Messsage Type
O UL EMM Message

(%) DL EMM Message

Type Namne

Message

ACCEPT
ATTACH_REIECT
AUTHENTICATION_REJECT
AUTHEMTICATION_REQUEST
C5_SERVICE_WQTIFICATION
DETACH_ACCEPT
DETACH_REQUEST _DL
DOWYNLIMK_MAS_TRANSPORT
EMM_INFORMATION
EMM_STATUS
GUTI_REALLOCATION_COMMAND
IDEMTITY_REQUEST
SECURITY_MODE_COMMAND

SERWICE_REIECT
TRACKING_AREA_UPDATE_ACCERT
TRACKIMG_AREA_UPDATE_REJECT

Hex Yalue Tnput

O ULESM Message
) DL ESM hessage

Inserthessage

Type
DL_EMM

MName
ATTACH_ACCEPT

SECURITY_PROTECTED_MWAS_MESSAGE_DMN

X

Apply

[ oekte | [Deeear [ ok

H Cancel ]

Figure 7-5

: NAS Message Insert Window

To generate a new message, first select one of the DL radio buttons in the Message Type box. (The UL radio
buttons exist to enable maximum flexibility of this tool, however, the current application does not require use

of the UL Message types.)

After specifying the message type, click New to display the desired NAS message in Message Structure box.
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NAS Message Insertion Procedure
1. Click the Insert Message icon or Edit, Insert Message.

2. Select Message Type.

hWlesszage Type
) UL EMM Wlessage ) UL ESMW Message
(*) DL EMM Wlessage ) DL ESMW Message

3. Select Message.
4. Double click or drag and drop to Insert Message window.

5. Click OK button.

Scenario Window

The Scenario Editor provides a simple interface for you to create and modify various test scenarios for the
eNodeB emulator. Use the DL RRC messages (which may contain NAS data) defined in N6062A LTE
Message Editor software as well as those you have pre-defined. Each scenario is divided into two sub-
scenarios:

e  Start Scenario

e Communication Scenario
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Start Scenario

The Start Scenario window defines master information block and system information block messages that
are broadcast by the PXT; you can double-click or drag and drop to place a selected MIB/SIB message in
Start Scenario box. The index in the Start Scenario box indicates the order of message transmission from
eNodeB.

Start Scenario

MIB Type Message
Master Information Black MIB

SIB Tyvpe Messagehlane
Systern Information Block Type 1 SIE1

Systermn Information SIBZ

Systemn Information

Figure 7-6: Start Scenario Window

Communication Scenario

The Communication Scenario window defines the desired message exchange between the PXT and a UE.
The UL RRC Message contains the name of a standard RRC Message (for example, rrcConnectionRequest).
The right-hand DL RRC Message column contains the name of the message that will be sent to the UE as a
result of receiving the UL RRC Message Type. The messages in the DL RRC column are those that have been
constructed by the user and appear in the RRC Window.

Some UL RRC messages can carry NAS messages inside them. For those messages, it is possible to further
qualify the DL RRC message that will be sent based on the NAS content of an UL RRC message. So, for a
received UL Information Transfer message at RRC, different DL RRC messages could be sent to the UE
depending on the NAS message that was carried inside the UL RRC Message.

Comrnunication Scenatio

RRC_COMNECTION_STATEQ

UL RRC Message N&S DL RRC Message
rrcConnectionReguest - RRCConnectionSetup
rrcConnectionSetupComplete ATTACH_REQUEST SecurityrnodeCommand
securityhodeComplete _ UEcapEnquiry
ueCapabilitylnformation _ RRCReconfiguration
ullnformation Transfer DETACH_REQUEST Detachaccept

Figure 7-7: Communication Scenario Window
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Communication Scenario
RRC_COMMECTION_STATED | |

UL RRC Message MAS DL RRC Message
rrcConnectionReguest _ RRCConnectionSetup
rrcConnectionSetupComplete ATTACH_REGUEST SecuritymodeCommand
secutityModeComplete _ UEcapEnguiry
ueCapabilityinformation _ RRCReconfiguration
ullnformation Transter [DETACH_HEQUEST -] DetachAccept

Mas Message [LIL EMM MESSAGE v

[DETACH_HEOUEST -~

JTTACH COMPLETE
ATTACH_REQLEST
AUTHENTICATIOM_FAILURE
AUTHENTIC ATION_RESPOMNSE

EXTENDED _SERVICE_REQIUEST

%LI%TI_HEALLOCATION_COMPLETE

PLETE

OTECTED_MAS_MESSAGE
EST

PDATE_COMPLETE
EEATE_HEQUEST

Figure 7-8: NAS Messages

¥ Message Editing Q@@

UL RRC Message :  rrcConnectionSetupComplete [UL_DCCH]

Nas Message UL EMM MESSAGE v
| ATTACH_REQUEST v
DL RRC Message : IDL Authentication v ]

[ ok ][ Cancel ]

As well as qualifying a message response based on the UL NAS message that is being carried, there is the
option to further qualify the response to certain messages based on message content.

The PDN Connectivity Request message can carry information on the Access Point Name. It is possible to
determine the response that should be sent based on the Access Point Name being carried inside the
message. This means that a different response can be sent in response to different PDN Connectivity
Request messages.
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¥ Message Editing

UL RRC Message :  ullnformationTransfer [UL_DCCH]

NasMessage  |UL ESM MESSAGE v
I PDM_COMNECTIVITY _REQUEST v l
[] Access Paint Name | ‘
DL RRC Message : IRRC Reconfig Second Context V]

[ OK ][ Cancel ]

User’s Guide

The Measurement Report message can carry a different measurement identity (or MeasID). A different
response can be sent to measurement reports containing different measurement identities — allowing a

certain report to trigger an automatic redirection to another cell, for example.

¥ Message Editing

UL RRC Message :  measurementReport [UL_DCCH]

EEX

MesID: |1 v
DL RRC Message : Other VJ

ok i cancel o]
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Extended Window

Using Extended Window, you can add a message that has been defined in the RRC message window to the
Custom Message, Page Message, or Release Message pane.

“# M6062A Protocol Message Editor

File Edit Encode Yiew  ‘Window  Help

EIDCIEIEREEY

8 B7_10M_TH1_v3.0.lbmf (2009-12) EEX

: E| Custom Message List Release Message List
h=
= Messages ame MNarme
MIE Measurement Report RRC Release Other
Sl RRC Release TAU
SIe2
Setup

DL Authentication

DL Security Command
Security Mode Command
LE Capahility Enguiry
RRC Reconfiguration

RRC Release Other

Page TMSI
Measuremnent Repart

DL TAU Accept < 3| ||« 2
DL Detach Accept
RRC Reconfiguration Re-er  Paging Message List Handaver Message List
RRC Reconfig Second Cory Mame Hame
Page Agilent IMST Page TMSI
RRC Release TAL Page Agilent IMSI
< | >
< )| ||= >

Ere | EBNe | BB |EBE«

Figure 7-9: Extended Window

On the PXT instrument, it is possible to send these on demand by pressing the appropriate softkeys under
the PXT Function menu.

Extended Message Insertion Procedure

1. Select a message in the All Message View.

N
All
Custom

Release

2. Select message and click the .7 icon (All/Custom/Release/Paging).
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File Transfer

A scenario file must be transferred to the PXT before it can be run. This is done using the procedure below.

File Transfer Procedure

1. Click = icon from the main tool bar or select File, File Transfer.

™1 Ele Edit Encode Yiew Window Help

EIDC B

Band7_10MHz_UM_TM3_LSTI_IntegrityDisabled_v1,0.LEMF (2009-03)

E=

SIB1
RRCConnectionSetup
sB2

MIB

2. Check the BSE Version (Default BSE V2.0), port (Default 9004), and
IP Address (for example: 192.168.1.60).

File Transfer X
|BsE V2.0 v| portioooe ] PAddress: | 192 . 188 . 1 . 60 | [ Connect ] [ Clnse ]
C:\Dutuments and Settingsianjohns\Desktop
File: Mame Path Edit Date

Band7_10MHz_UM_... C\Documents and Setting... 10/13/2010_10:1...

¥

File MName

3. Click Connect Button.
4. Click the check box from the File Name list.

5. Click icon

6. The file is transferred to the scenario file directory in the PXT. A message indicates whether the
message has been successfully transferred.

7. On the PXT, select BSE, Mode Setup, Call Scenario to see the list of available scenario files, and
check that the file you downloaded is listed.
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Load Scenario File

Scenario File Name

CH Bandwidth
MCC

MNC
Message L1/L2
RFN Tl

File Name

<null>
A_B20_SIS0_AES_security_NASTntAndRRCINtCiph_1.LBMFE
A_B20_SISO_AES_security_RRCIntCiphOnly_1.LBMF
A_B20_SISO_AES_security_RRCIntOnly_1.LBMF
A_Band20_MIMO_noAuth_IPstandalone.lbmf
Band13_10MHz_UM_TM1_SecurityDisabled_v1.0.LBMF
Band7_10MHz_UM_TM1_LSTI_InteqrityDisabled_v1.0.LBMF
Band7_10MHz_UM_TM1_LSTI_IntegrityDisabled_v1.1.LBMF
Band7_10MHz_UM_TM3_LSTI_IntegrityDisabled_v1.1.LBMF
Band7_20MHz_UM_TM3_LSTI_IntegrityDisabled_v1.1 WIF.lbmf
Band7_20MHz_UM_TM3_LSTI_IntegrityDisabled_v1.1.LBMF
LGE_Band20_TM1_CKW.LBMF
March_Band7_MIMO_AES_TM3.LBMF
test.LBMF

Description
Clear Scenario

BasicLTEBSEMessage
BasicLTEBSEMessage
BasicLTEBSEMessage
BasicLTEBSEMessage
BasicLTEBSEMessage
BasicLTEBSEMessage
BasicLTEBSEMessage
BasicLTEBSEMessage
BasicLTEBSEMessage
BasicLTEBSEMessage
BasicLTEBSEMessage
BasicLTEBSEMessage
BasicLTEBSEMessage

Load (Enter)
| Delete (8K Spo) |

| cancel (gse) |

06:49:36 PM OCT 13, 2010

Trig: Intl 10MHz  Ready

Call Scenario

Load

Delete

Cancel

Figure 7-10: Verifying a Successful Download
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Examples of Common

Setting the Channel Quality Indicator (CQl) Value

Changes

Agilent LTE N6062A Message Editor
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1. Locate the rrcConnectionSetup message on the RRC message tab. The cqi-ReportConfig Information
Element is near the bottom of this message.

e

=~ RRC Message List
- S§IB1

- 5182

& Setup

- DL_Auth

- DL_Sec

- UEcap

- DetachAccept
- PagingCs

- Page TMSI

-+ RRC Reconfigu

‘e @/

- Sec_mod_com

- RRCReconfiguration

- RRC Reconfig Second Con

E=e

ration Re-er

ifgd accumulationEnabled : TRUE

----- & p0-UE-PUCCH : 0

i pSR5-Offset : 3
W fiterCoefficient : fc4
- tpc-PDCCH-ConfigPUCCH
tpc-PDCCH-ConfigPUSCH
-+ soundingRS-UL-ConfigDedicated
tennalnfo
P defaultValue
EIEU:L schedulingRequestConfig
=-Tg setup
g sr-PUCCH-Resourcelndex : 41
Ag? sr-ConfigIndex ; 27
g dsr-TransMax : n16
cgi-ReportConfig-v320 : Optional
-2 antennalnfo-va20 : Optional
rif-TimersAndConstants-ro
nonCriticalExtension : Optional

BuiltinMName SEQUENCE
OI-ReportConfig

[ Refliame

Detail Information | Qutput | Hex Viewer
Mame Value
MAME cgi-ReportConfig

Figure 7-11: Accessing CQI Reporting

2. The Information Element (IE) may not be present in the message — which indicates to the UE that CQI
reporting is not being configured in this message. To include the IE, highlight the cgi-ReportingConfig
field as shown above and notice that an IE Addition box becomes available under the Detail Information
tab. Select the box marked IE Addition. This enables the cqi-ReportConfig information to become visible

as shown below.
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SRR ) My o LU W IRV g WLy |

-l tpc PDCCH- Cnnf‘gPUSCH
28 M caiReportContig|
. cqn—RepnrtModeAperindic 12
: Q nomPDSCH-RS-EPRE-Offset @ 0
=) H‘ﬁq, cqi-ReportPeriodic

&y soundingRS-UL-CanfigDedicated

D 3‘91 antennalnfo

+ defaultvalue

D 3‘91 schedulingRequestConfig

=-TFg setup
-l sr-PUCCH-Resourcelndex : 41
g sr-Configindex : 27
- g der-TransMax : n16

rai DamarbtCmenfin @00« Oistine=]

Detail Information | Output | Hex Viewer

Mame Value

NAME cqi-ReportConfig
BuiltinMame  SEQUEMCE
RefMame

CQI-ReportConfig
IE Addition

Figure 7-12: Enabling CQI Report Configuration

3. Disable Aperiodic CQl reporting, by highlighting the cqi-ReportModeAperiodic field and de-selecting the

|IE Addition box.

g TRC-PLILLH-LOMTIQRUSLH
=- j‘_u cqn—RepurtCnnf‘g
nomPDSCH-RS-EPRE-Offset : 0
= cqi-ReportPeriodic
+ soundingRS-UL-ConfigDedicated
2 3:-1 antennalnfo

defaukvalue
D 3% schedulingRequestConfig
=-Tg setup
G sr-PUCCH-Resourcelndex : 41
g sr-ConfigIndex : 27
------ ‘g dsr-TransMax : ni6
----- cqi-ReportConfig-v320 : Optional

antannaTnf A0 = Pintimm=l

4.

Detail Information | Output | Hex Viewer
Name Value

MNAME cqi-ReportModeAperio...
BuiltinMarme EMUMERATED

IE Addition

Figure 7-13: Disabling Aperiodic CQI Reporting

Enable Periodic CQl reporting, by right-clicking the cqi-ReportPeriodic IE and selecting “setup” from the
drop-down list of possible options.
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6.

&
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Eﬂ c.qi-RepnrtCD nﬂg_

##i cg-ReportModeAperiodic
g nomPDSCH-RS-EPRE-Offset : 0

- T

release

. - release
- SOLUN |ngRS-UL-CDnﬁg
=-Bey, antennalnfo

! defaulValue

EIE% schedulingRegquestConfig

=-Tg setup

I sr-PUCCH-Resourcelndex : 41
g sr-Configindex : 27
‘i dsr-TransMax : n16
cqi-ReportConfig-w320 : Optional

antennalnfo-va20 @ Optional

~Ze: rf-TimersAndConstants-rg

IE Addition

Pl o e P | B e o I e T e
Detail Information | Output | Hex Viewer
Marme Value
MAME cqi-ReportPeriodic
BuitinMame  CHOICE
RefName CQI-ReportPeriodic

Figure 7-14: Enabling Periodic CQI Reporting

User’s Guide

The most basic type of CQl reporting is Periodic Wideband CQl reporting. Setting the values shown in

the diagram below enables this.

=-Bey, coi-ReportPeriodic
= -TFg setup
§# coi-PUCCH-Resourcelndex : 0
& coi-omi-Canfigindex : 26
=By cgi-FormatindicatarPeriodic

widebandCQl

B simultaneousAckNackandCal: TRUE

Figure 7-15: Settings for Periodic Wideband CQI Reporting

Make sure you encode the message by clicking the Encode Message button. The Setup message in the

RRC Message List changes its color, from red to black, indicating the message is encoded.

If you navigate away from the message before pressing the Encode Message
button, your changes are lost.

1.

Select File, Save As... and save the file with a new name, retaining the .LBMF extension.
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Changing the Initial DUT IP Address

1. Check the NAS message list:
e If the list includes ATTACH ACCEPT, then go to step 6, below.

o Ifthe list also includes ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST message
then go to step 9, below.

2. Locate the RRCreconfiguration message on the RRC message tab. Near the top of message is the
dedicatedinfoNASList content. Right-click on this message. A pop-up window displays the text, “Value
Changed”. Select this and then copy the contents (Ctrl+C) to the clipboard of your pc.

OB e/ e 7

= RRC Message List = Fa' Message Name | RRCReconfiguration
SIBtypel =-Fg DL-DCCHMessage
RRCConnecTorReEDme &9, ressage
RRCCONnECtionSetun “B oy ot
SIB2 B
mib modi = ?_g rreConnectionReconfiguration
DLIEfDrmatan auth 0 rre-Transactionldentifier : 0
DLInformation_SecCommand =3 eriticalExtensions
SecurityrmodeCommand ER

= T& rmeConnectionRecanfiguration-ra
measConfig : Optional
mohilityContralinfo : Optional
=T degicatedinfollaS]jst

RRCReconfiguration

O TR e
DL _info_CloeselE
RRCConnectionReleass

-

Figure 7-16: Copy Contents of Sequence 1

3. Select the NAS tab, and click on the Insert Message icon.

@ N6062A Protocol Message Editor - [Band7_SISO_AES.LBMF (2009-03)]

: File  Edit Encode  Wiew  Window  Help

eI E = Y

=

o= [F=_ I
== =

= MAS Message List

Figure 7-17: Click Insert Message Icon
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The following screen is displayed. Copy the dedicatedinfoNASList message contents into the box as
shown. Select DL EMIM Message and click on Apply.

',_ NAS Message Insert

hlesszage Type
O UL En hiessage

) DL EmM Message

Type Mame

O ULESM hiessage
O DLESM hiessage

Hex Walue Input

X

0742010F06404 14058010200175201C10105034C474505019C30 70975
EQ4FEFEOECESS32500BF64 1405801230 1A ABBCCO0174F

Apply

Inserthiessage

Message

ATTACH_ACCEPT
ATTACH_REIECT
AUTHENTICATION_REJECT
AUTHEMTICATION_REQUEST
C5_SERWICE_MOTIFICATION
DETACH_ACCEPT
DETACH_REQUEST_DL
DOMLINE_MAS_TRAMSPORT
EMM_INFORMATION
EMM_STATUS

GUTI REALLOCATION COMMAND

Figure 7-18: Add New Hex Value

Type

MName

When you select, Apply, the Message Editor decodes the contents and
displays the type and name of the message.

', NAS Message Insert

hleszzage Type

O UL EMM Message O UL ESM Message

® DL EMM Message O DL ESM Message

Hex Walue Tnput

X

Apply

Type Mame IIVlnsertl\ﬂessage
Message Type Mame
ATTACH_ACCEPT DL_EMM ATTACH_ACCERT

ATTACH_REJECT
AUTHENTICATION_REJECT
AUTHEMTICATION_REQUEST
CS_SERWICE_MOTIFICATION
DETACH_ACCEPT
DETACH_REQUEST _DL
DOWMNLINE_MAS_TRAMSPORT
EMM_IMNFORMATION

EMM_STATUS
GUTI_REALLOCATION _COMMAND
IDEMTITY_REQUEST

SECURITY _MODE_COMMAMND
SECURITY_PROTECTED_MAS_MESSAGE_DMN
SERVICE_REJECT
TRACKING_AREA_UPDATE_ACCERT
TRACKING_AREA_UPDATE_REJECT

Delete Delete A ’ K Cancel

5.

Figure 7-19: New ATTACH ACCEPT Message

Click OK. The new ATTACH ACCEPT message is now present in the NAS message list.
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6. Click the ATTACH ACCEPT message, which includes further embedded NAS information. Find the
NasMessageDnData message. Right-click on the contents, select “Value Changed” and copy (Ctrl+C)
the contents to your pc clipboard.

7. Select the Insert Message button and copy the contents of the NasMessageDnData message into the
field as shown. Select DL ESM Message and click, Apply.

B NAs Message Insert r‘5_<

hlesssage Type Hex Walue Input
O UL EMM Message O UL ESM Message 5201C10105034C4?4505019CEID639?5ED4FEFEDEDE5832] ’—‘
Apply

O DL EMM Message (& DL ESM Message

Type Mame Inserthlessage

Message Type Marne
ACTIVATE_DEDICATED_EPS_BEARER_COMTEXT_REQUEST

ACTIVATE_DEFAULT _EPS_BEARER_COMTEXT _REQUEST
BEARER_RESOURCE_ALLOCATION_REIECT

BEARER_RESOURCE_MODIFICATION_REIECT

MEACTHATE CNC DEADCD ~ORITEWT DEF IECT

Figure 7-20: DL ESM Message

8. This identifies the message as an ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST message.
Click OK.

Message
ACTIVATE_DEDICATED_EPS_BEARER_CONTEXT_REQUEST EAR | TEXT REQUEST
ACTIVATE_DEFALLT _EPS_BEARER_COMTEXT_REQUEST
BEARER_RESOURCE_ALLOCATION_REIECT
BEARER_RESOURCE_MODIFICATION_REJECT
DEACTIVATE_EPS_BEARER_COMTEXT_REQUEST
ESM_INFORMATION_REQUEST
ESM_STATUS
MODIFY_EPS_BEARER_COMTEXT _REQUEST
POMN_COMMECTIWITY _REIECT
POMN_DISCONMECT_REJECT

Delete Delete Al

oK |

Cancel ]

I U TSl AABBLTIT

Figure 7-21: ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST Message

28



Agilent LTE N6062A Message Editor
User’s Guide

9. Select the ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST message shown in the NAS
message list. The DUT IP address information now appears near the end of the message.

=

[=-MAS Message List

- SECURITY_MODE_COMMAND
e ATTACH ACCEPT

- ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST

=7
=-¥2' Message Name : DL ESM Message
Bgﬁl ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST

i@ EPSBearerldentity : 5

Elguq, PDMAddress
iR spare : PRESENT

@ [T pva (1)~
“-me PDNAddre' o 27 192.168.1.52

IPvdvi (3)

Figure 7-22: DUT IP Address Information

10. For this example, change the IP address from 192.168.1.52 IPv4 to 021F:29FF:FE7C:8F51 IPv6. Enter the
address in the form shown: 4 groups of 4 characters, separated by colons. It is not possible to use the
shortened notation using double colons. Entering an IPv4v6 address requires inputting a separate
address for both the IPv4 and the IPv6 component of the address.

11. To complete this example, go to step 4 in the next section, below. If you wish to transmit other
addressing options, continue to the next section, “Signaling Other Addressing Options”.

Signaling Other Addressing Options

The ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST message is also the method for signaling

other addressing options.

e Right-clicking on the message header displays a list of these options.

e Left-clicking on each of these options adds additional fields to the message.

It is possible to enter a list of separate addressing options within a single message. In the example below,
ContainerCfgs is set to 3, enabling you to provide 3 addresses to the UE when the
ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST message is transmitted to the UE. This example

sets one P-CSCF and two DNS addresses.
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# ATTACH_ACCEPT

Figure 7-23: DUT IP Address Additional Information

1. Select the ProtocolConfigurationOptions line. Right-click on ContainerCfgs and change the content to

3.

ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST

6 E=e|/
(- NAS Message List B- T:i" Message Name : DL ESM Message
- SECURITY_MODE_COMMAND 25 EPS | X

#g? EPSBearerldentity : 5
9 ProcedureTransactionIdentity : 1
oy, EPSQoS

0 QCl: 9

-Bay, AccessPointiame

Lo tayt 1 agilent

PDMAddress

g spare : PRESENT

PDNType : IPvE (2)

EEN Contanercros IR

=gy, [00]

--Rg Containerld : unknown

g Length : 0
~imon Contents :

E| E“:L [01]

--Rg Containerld : unknown

g Length : 0
- Contents :

B ?=1 [02]

- ig ContainerId : unknown
9 Length : O
e Contents @

Figure 7-24: Creating Containerlds for IP Addresses
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MegotiatedQo5
MegotiatedLLCSAPI
RadioPriority
PacketFlowldentifier
APNAMER
ESMCause

- pONAddressInformation : 021F:29F
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& ‘e -

= MAS Message List

i SECURITY_MODE_COMMAND
ATTACH ACCFPT

| ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST

E®e| /
-4 Message Name : UL EMM Message
E|--§=_Il ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST
g EPSBearerldentity : 5
g ProcedureTransactionIdentity : 1
-Ba) EPSQoS
i @ QCl:o
=-Bey. AccessPointName
¢ hemo et agilent
), PDNAddress
g spare : PRESENT
& PDNType : IPV6 (2)
wo PONAddressInformation ; 021 F29FFFE7 CBFS]
. ProtocolConfigurationOptions [OPT] ™
g ConfigurationProtocal : 0
T3 ProtocolCfgs
=g ContainerCfgs
E-gay. [00]
] Containerld : ,]

Length : 0 "o cocr 1pve Address (1)

o CONC@NES 1M CN Subsystern Signaling Flag (2)
DNS Server IPvE Address (3)
Policy Control rejection code (4)
Selected Bearer Control Mode (5)
Reserved (&)

DSMIPve Home Agent Address (7)
DSMIPvE Home Network Prefi (8)
DSMIPve IPv4 Home Agent Address (9)
Reserved (10)

Reserved (11)

P-CSCF IPv4 Address (12)

DNS Server IPv4 Address (13)
MSISDN (14)

IFOM-Support (15)

Pv4 Link MTU (16)

Figure 7-25: DUT IP Address Additional Information Options

2. Right-click on Containerld, select “Value Change” and then access the additional information element
options shown in figure 7-25 by selecting the drop-down list.

3. Use the three containerld fields to select and populate each address for the information elements:

e P-CSCF IPv6 Address
e DNS Server IPv6 Address
e DNS Server IPv4 Address

The resulting contents are shown in figure 7-26.

The UE IP address is entered in the form 021F:29FF:FE7C:8F51.

e The server addresses also include the header information (resulting in 32

characters), and the colon separators must be omitted.
The UE IPv4 address is entered in dot separated decimal.

The server IPv4 addresses are entered in HEX with no separators.
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E®e| s
B NAS Message List E-¥2’ Message Mame : UL EMM Message
- SECURITY_MODE_COMMAND =-3ay ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST
L ATTACH ACCEDT Q EPSBearerldentity : 5
EETIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST K@ Procedure Transactionldentity = 2
B Bay, EPSQoS
S oLgQo:e

B -Buy, AccessPointiame
¢ heomm oyt : agilent
E| 9% PDNAddress
. i~Kgh spare : PRESENT
g PDNType : IPv6 (2)
. eten PDNAddressInformation @ 021F:28FF:FE7C:8F51
=8 5‘01 ProtocolConfigurationOptions [OPT]
----- ‘g ConfigurationProtocol : 0
------ i~Tg ProtocolCfgs
El?_g ContainerCfgs

- 00]
! . Containerld : P-CSCF IPv6 Address (1) ™y

Q Length : 16
wan Contents : 2001000000000000021001FFFE234567

B Buw. [01]
. Containerld : DNS Server IPv4 Address (13)
. - Length : 4
P o Contents : COABN134
B 9% [02]
----- b4 Containerld : DNS Server IPv6 Address (3)]
- fgP Length : 16
----- mon Contents @ 2001000000000000021001FFFE234567

.

Figure 7-26: DUT IP Address Additional Information Options Final Content

4. Make sure you encode the message by clicking the Encode Message button.

m If you navigate away from the message before pressing the Encode Message
button, your changes will be lost.

5. After clicking the Encode Message button, the output tab displays a newly encoded value. This is now
the new ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST message content. Highlight and
copy this value to your pc clipboard (using Ctrl+C) omitting the first Ox.

Detail Information | Output | Hex Viewer

This Message [ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST] Encode Success -
old Encode Value @ 0x2202C1010209086167696C656E74320501C0A80134

new Forodes Walus -

EER5202C1010908076167090C050E740902021F209FFFE/ CBFS1272E800001102001000000000000021001FFFEZ
4567000D04C0AB01340003102001000000000000021001FFFE234567

Figure 7-27: Copy New Message Content Without “0x”
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6. Select the ATTACH ACCEPT Message. Right-click on the NasMessageDnData message. Select Value
Changed and paste the new value (using Ctrl+V) into the field.

@

- MAS Message List

ATTACH_ACCEPT
e UEFR

= |

=] Eﬂ‘ Message Mame : DL EMM Message

E-Joy, ATTACH_ACCEPT
&P SecurityHeaderType : 0
P EPSAttachResult : EPS only (1)
& SpareHalfOctet : PRESENT
By T3412Value
H & Unit : value indicates that the timer is deactivated (7)
. P TimerValue : 0
=-Tg TAlList

E-£1% [00]
=-Tg Type2
E-ge [00]
P MCCL: 0
P MCC2: 0
P MCC3 0 1
g MNCL : 0
P MNC2: 0
& MNC3 : 15

w1 TAC : 0001
-

& Bn‘“ﬂﬂ—‘
» NasMessageDnData : 5202C1010908076167696C656E740902021F25FFFE7 CBF51272E600001102001000000000000021001FF

FE234567)

+f GUITLOPT]
. OB GUTI
: * & spare : PRESENT

Figure 7-28: Paste New Message Content Without “0x”

7. Click on Encode Message to create the new contents for the ATTACH ACCEPT message. When done,
copy (using Ctrl+C) the new encoded value as shown below, omitting the first 0x. This is the new
content of your RRCReconfiguration message.

] @

| - |,f"
[=-NAS Message

- SECURITY_MODE_COMMAND
[® ATTACH_ACCEPT]
" ACTIVATE_DEFAULT_EPS_BEARER_CONTEXT_REQUEST

E=e /
= #%’ Message Name : DL EMM Message
= g‘ﬂ, ATTACH_ACCEPT
P SecurityHeaderType : 0
@ EPSAttachResult : EPS only (1)
g? SpareHalfOctet : PRESENT
£ 3. T3412value
. @ Unit : value indicates that the timer is deactivated (7)
g Timervalue : 0

T TALst
B [00]
-Fg Type2
=3, [00]
g MCCL 0
g MCC2 i 0
SR MCCIl
g MNCL: 0
SE@ MNC2: 0
MNC3 : 15
wen TAC : 0001
MMessageContainer

g spare : PRESENT

K OddEven : PRESENT
g IdentityType : PRESENT
9 MCC1: 0

P MCC2: 0

B9 MCC3 1 1

g MNCL: 0

& MNC2 1 1

< i

Detail Information | Output |Hex Viewer

This Message [ATTACH_ACCEPT] Encode Success

old Encode Value : 0x074201E00640330166000100145201C1010908076167696C656E740501C0AB0133500BF6330166012301 AABBCCO0174F
new Fncode Malue -

[8w074201E0064000F100000100485202C1010908076167696C656E74090202 1 F29FFFE7 CBF51272E800001102001000000000000021001FFFE23
0D04C0A801340003102001000000000000021001FFFE234567500BF600F110012301AABBCCO0174F

4567 01 I

Figure 7-29: Copy New RRCReconfiguration Message Content Without “0x”

8. Return to the RRC tab. Select the RRCReconfiguration message and find the dedicatedNASInfo field.
Paste (using Ctrl+V) your ATTACH ACCEPT message contents (minus the starting 0x) into this field,
and click the Encode Message button.
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& [} EE®e|/
[=-RRC Message % reportConfigToRemoveList

5
MIB ¥ reportConfigToAddModList
-8Bl %% measld ToRemoveList
SIB2 Ty measld ToAddModList
- Setup quantityConfig : Optional
DL Authentication - measGapConfig

s-Measure
preRegistrationInfoHRPD : Optional
+ speedStatePars

RRC Reconfiguration mohiliyContrallnfn - Ontianal

~ DL Security Command
Security Mode Command

T dedicatedInfoNASList

Figure 7-30: Paste New RRCReconfiguration Message Content Without “0x”

9. Select File, Save As... and save the file with a new name, retaining the .LBMF extension.

34

Page THSI i
- Measurement Report T Tt u 3 &

DL TAU Accept =] 'Eh srb-ToAddModList =
- DL Detach Accept =-Fa SEQ 1

RRC Reconfiguration Re-entry 0 srb-Identity @ 2
- RRC Reconfig Second Context =B, ric-Config

Page Agilent MST E|-§n1 explicitValue L4
- RRC Release TAU =g am
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8 Service and Support

Calling Agilent Technologies

Agilent Technologies has offices around the world to provide you with complete support for your products.
For help, to obtain servicing information or to order replacement parts, contact the nearest Agilent
Technologies office listed below. In any correspondence or telephone conversations, you will need the

product number, full serial number, software revision and Software and Technical Support Contract (STSC)
details.

Press the INFO front panel key to view the product number (E6621A), serial number, and software revision
information and STSC expiry date.
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Locations for Agilent Technologies

Online assistance: http://www.agilent.com/find/assist

If you do not have access to the Internet, one of these centers can direct you to your nearest representative:

If you have a current STSC for the E6621A, you can contact Agilent at the email addresses listed in
“Software and Technical Support Contracts” on page 37.

Should the Declaration of Conformity be required, please contact an Agilent Sales Representative, or the

closest Agilent Sales Office. Alternately, contact Agilent at: www.agilent.com.

Americas

Brazil Canada Mexico

(11) 4197 3500 (877) 894 4414 01800 5064 800
United States

(800) 829 4444

Asia Pacific

Australia India Malaysia

1800 629 485 1800 112 929 1800 888 848
China Japan Singapore

800 810 0189 0120 (421) 345 1800 375 8100
Hong Kong Korea Taiwan

800 938 693 080 769 0800 0800 047 866
Other Asian Countries:

www.agilent.com/find/contactus

Europe & Middle East

Austria Germany Spain

43 (0) 1360 277 1571 49 (0) 7031 464 6333 34 (91) 631 3300
Belgium Ireland Sweden

32(0) 24049340 1890 924 204 0200-88 22 55
Denmark Israel Switzerland
4570131515 972-3-9288-504/544 0800 80 53 53
Finland Italy United Kingdom
358 (0) 10 855 2100 3902 92 60 8484 44 (0) 118 9276201
France Netherlands

0825010 700" 31(0) 20 547 2111

*0.125 €/minute

Other Asian Countries:
www.agilent.com/find/contactus
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Software and Technical Support Contracts

Software and Technical Support Contracts (STSC) entitle you to software updates and feature enhancements,
as well as direct access to a technical expert for technical support for a fixed period, usually one year.

The STSC gives you direct access to technical product experts to increase your productivity and minimize the
software difficulties you encounter. These technical support engineers are experts on the N6070A series
Signaling Conformance Test solution, the E6621A PXT test set, and its complementary software products.
They have instant access to instruments and software to enable them to resolve your issues as quickly as
possible. Agilent will investigate all software defects and operational problems reported through the
technical support channel. Upon completion of the investigation, we will advise you on possible solutions
and functional alternatives. Where possible, Agilent will provide software releases to address problems
caused by defects in the firmware or software.

STSCs for the Agilent E6621A PXT

The N6050AS STSC covers the N6050A, N6051A and N6052A software applications running on the E6621A
PXT wireless communications test set, plus the associated N6061A and N6062A PC software applications.

If you have a Software and Technical Support Contract, there are three methods of accessing your technical
support:

e Web-based support: My Support Center
e E-mail support
e Phone support

For fastest response times, we recommend using the web-based or email access methods as these provide
the most direct route to your technical support expert. All support cases may be viewed and tracked through
the online support center (My Support Center), regardless of how you initially contacted technical support.

Web-based support

You can directly enter and manage your support requests online via
www.agilent.com/find/mysupportcenter.

The first time you use My Support Center you will be asked to create a profile and provide proof of
entitlement. Once your profile is created, you can use the online support center to enter your support
request.

Each support request will be given a unique case number which you can use to track the progress of your
support case. A technical expert will contact you via phone or email (whichever you have stated as your
preferred option) to resolve your issue.

English, Japanese, Korean, and Mandarin local language support is available.
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E-mail support

You can also contact our technical support at the following e-mail addresses:

wireless_test_support_americas@agilent.com
wireless_test_support_japan@agilent.com
wireless_test_support_europe@agilent.com
wireless_test_support_asia@agilent.com

wireless_test_support_korea@agilent.com

Your support request will be routed to a technical expert who will contact you via e-mail or phone
(whichever you have stated as your preferred option) to help resolve your issue.

English, Japanese, Korean, and Mandarin local language support is available.

Phone support

If you prefer to speak to someone directly, you can call the Agilent customer contact centers at the numbers
on page 36 of this document. For Japan, please use the phone number 0120-444-823.

The customer contact center will route your request to a technical support expert, who will contact you
about your support request via phone or email. Local language support is available in many countries.
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